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Introduction: Purpose and Intent 

Public Hearings are a critical portion in the life of a NCDOT project. NCDOT uses these meetings 
to communicate the specifics of the project with the public and receive feedback. As mentioned 
in the Public Involvement Map Information Guide, “The goal of public engagement is to create 
meaningful opportunities for communication to and from the public during the development 
process.” The Public Hearing Maps are an important tool for communicating the design 
elements of a developing project. They help communicate the existing conditions, proposed 
conditions, design alternatives and more. The purpose of this manual is to discuss the workflow 
and tools used to create the hearing maps using OpenRoads Designer. 

There are four different hearing maps that are used during the public involvement portion of a 
project: 

• Enhanced Study Area Map 

• Conceptual/Meeting Map 

• Corridor Public Hearing Map 

• Design Public Hearing Map 

This manual covers tools and workflows only for the Design hearing map, which is produced by 
the Roadway Unit.  

The Designer is directed to “Public Involvement Map Information Guide 8-03-2020” for 
additional guidance on the types of hearing maps and information shown on various maps.  

Overview of Public Hearing Map Workflow 

The general overview of the workflow is: 

1. Create Public hearing map file using the NCDOT hearing map seed file 
2. Attach the various existing and design files as references 
3. Layout the public hearing map sheets 
4. Create shapes for bounding prescribed existing and proposed features such as buildings, 

bodies of water, historical boundaries, pavements and bridges. 
5. Add various labels and cells as required for hearing maps. 
6. Finalize sheets by adding annotations. 
7. Plot the public hearing maps for use. 



 

Module 14 – Public Hearing Map 

 

 

Page | 5  

 

 

Exercise 1: Public Hearing Map File Creation 

In this section, we will demonstrate how public hearing maps are initiated. 

You will create the DGN file which will contain design public hearing map. 

 

1. Launch OpenRoads Designer CONNECT Edition by double-clicking on the NCDOT 
Roadway OpenRoads icon on your desktop. 

 

2. Set the Workspace, Workset and Role 

A. Select DOT-US North Carolina as the Workspace. 

B. Select Training-RD_R-2635C as the Workset. 

C. Select NCDOT_Roadway as the Role. 

 

NOTE: Please be aware that the workset (Training-RD_R-2635C) is distinct from the tip number 
assigned to the example project (HL-0008F) used in this module. This is intended to harmonize 
with the configuration file settings applied across all other training modules.  

 

3. Create a new file by clicking the New file button and navigate to the Module 14 (Public 
Hearing Map) folder. 
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4. Create file …/Roadway/Sheets/HL-0008F_RDY_PHM.dgn in the location as shown below, 
paying attention to choose the seed file for hearing maps.  

NOTE: The Public Hearing Map seed file location is: 
C:\NCDOT_CONNECT_WORKSPACE\Configuration_10_12\WorkSpaces\DOT-US North 
Carolina\Roles\NCDOT_Roadway\Standards\Seed\Seed_Hearing Map.dgn. 

5. Click save to create the file. 

NOTE: Public hearing map DGN files are set up differently than normal files, thus there is a 
special seed file. The hearing map seed file streamlines the work of creating the multiple 
different drawings and sheet models that are needed. 

Review Contents of Public Hearing Map Seed File 

6. To review the models that are present, open the model manager dialog (OpenRoads 
Modeling > Home > Primary > Models). 
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7. Review the models in the dgn file just created, which exist because of the seed file used. 

A. Each model is generally named so that its focus is on a separate element such as the 
RDY PHM Exist Water Shape which is specifically designated for creating shapes of 
existing water bodies. 

B. Models Named “RDY CPHM…” are for corridor hearings as a place to store alternatives 
shapes. 

C. Models named “RDY PHM…” are used for both corridor hearings and design hearings. 

 

NOTE: As the seed file is enhanced over time, the list of models may differ from the image 
above. 
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8. These models are already referenced together to help ensure proper plotting later on 
and so the designer can focus on assembling the project specific data.  Since the models 
are already referenced properly, then the sheets are ready to plot with minimal need to 
adjust reference files. 

A. RDY PHM Default 

• All the other models are referenced to the default model without nesting. 

• We will add additional references specific to the project. 

• The slot number (and thus the update sequence) is carefully crafted in this reference 
list so that we can more efficiently plot sheets without transparency overlaps later 
on. 

• Thus, when the default model is later used for producing sheets, all the project data 
and the shapes we create for the map will be shown on the sheets. 
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B. The PHM models are used for creating hearing map data and only have 1 attachment 
which is the RDY PHM Default model, with a live nesting depth of 1.  Thus, in these 
hearing map models, we will be able to see the project specific data attached to the 
default model. For example, note that the Existing ROW Shapes model has the default 
model attached with nest depth of 1. 
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Exercise 2: Attach Reference Files and Aerial Image 

In this section we will attach the various existing and proposed files associated with the project, 
which are needed for a public hearing map display.  The information from these files includes 
the existing features such as property lines, existing right of way and existing roadway limits.  
Proposed features we will need to include are the proposed roadway and proposed right of 
way. The information from these files will provide us with a base for creating the hearing maps. 

1. Switch back to the Default model if needed. 

 

Attach Reference Files 

2. Open the Reference Manager, (OpenRoads Modeling > Home > Primary > Reference) 
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3. As noted above, there are many reference attachments here already. These are the 
models within this same DGN file. 

 

4. For the public hearing maps, information from the final survey folder will need to be 
attached. Select Attach Reference in the References dialog. 

 

5. In the dialog, navigate to the final survey folder. Attach the survey files listed below. 

A. …\Final Survey\HL-0008F_ncdot_FS.dgn 
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B. …\Final Survey\HL-0008F_ls_wll.dgn 

6. Navigate to the Design folder. Attach HPB file …\Design\HL-0008F-HPB Boundary.dgn 
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7. For each of these attachments, pay special attention to: 

A. Assign logical name for the reference files. This allows pen tables to call the reference 

file by unique logical name and print it with proper shading, color, priority, or 

transparency. 

 

B. Set the attachment method to Coincident World. 

 

C. You do not want any nested references. 
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NOTE: Setting the global line style scale to reference is a precaution against the files 
having originated in GEOPAK SS2. The way that scales are handled differs in OpenRoads 
Designer from what was done in SS2.  By using the scale as defined in reference the line 
styles will be presented appropriately.  If you ever notice line scales in a reference file 
being too large or too small, then check this setting. 

8. Then, attach the roadway design files.  Be sure to select the “Interactive” method of 
attachment to see the window shown below.  Otherwise, you will need to double-click 
the file afterwards to see it. 

 

A. …\Roadway\Alignments\HL-0008F-RDY-ALT2A-ALG-Y1.dgn 

B. …\Roadway\Alignments\HL-0008F-RDY-ALT2A-ALG-DWY.dgn 

C. …\Roadway\Alignments\HL-0008F-RDY-ALT2A-ALG_L.dgn 
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D. …\Roadway\Design\ HL-0008F-RDY-ALT2A-ROW.dgn 

E. …\Roadway\Design\ HL-0008F -RDY-ALT2A-SS. Dgn 

 

9. Then attach …\Roadway\Design\ HL-0008F_RDY_DSN.dgn except attach the DSN file 
with live nesting depth of 1. 

NOTE: The DSN file for a project will have the various corridor model files attached as reference 
which is why we are using nesting for this attachment. 
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Attach Aerial Image 

There are two workflows shown in this section. 

The first section is what we will use in class. It loads the image from a locally downloaded MrSID 
file. Thus no internet connection is needed and the image is always available. However, it is not 
automatically updated. 

In the second workflow, we show how to attach the image using WMS server. This is often 
quicker and easier but loads the image from a remote server which is sometimes unavailable. In 
a classroom for example, you may have no live connection to the internet. 

1. Continue in the same file …Roadway/Sheets/HL-0008F_RDY_PHM.dgn 

2. Open the Models Manager and switch to the model named “RDY PHM Raster” by 
double click on the model’s name. 

 

3. You will note that the contents of the Default model are shown because, as noted in 
Exercise 1, the various models in the seed file have already had the various required 
reference attachments set up. 
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4. Open the raster manager under Attach Tools. (OpenRoads Modeling > Home > Primary 
> Attach Tools > Raster Manager) 

 

5. If using a WMS server for images, skip to Step 17. 

Attach Aerial Image from Local Image Files 

6. One the complications of using local files is that we need to ensure that our preferences 
are consistent with the image being used. By default, OpenRoads Designer expects the 
image units to be metric, which we will need to change. 
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7. Go to (File > Settings > User > Preferences) 
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8. Confirm the following settings. 

 

9. Click OK in the preferences dialog. 

10. Return to the DGN interface with the back arrow. 
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11. Open the Raster Manager (OpenRoads Modeling > Home > Primary > Raster Manager) 

12. In the raster manager go to File > Attach > Raster 
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13. Choose the four SID files in folder …/Final Survey/Ortho/ 

 

14. Set symbology and other settings as shown below. 

 

15. Click Attach. 
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Note: you can find the tile numbers for your project by navigating (NCDOT > Raster > 
Aerial Tiles) 
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  Will display the tiles number 

 

16. Skip to step 20. 
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Attach Image using WMS Server 

If using a WMS server, start here to attach raster. 

17. In the Raster Manager menu, go to File > Attach > WMS 

 

18. Open the file named OneMapLatestOrtho_AttachSettings.xwms from the workspace 
folder.  

 

NOTE: The exact location of workspaces and thus this file may vary by organization. Inside the 
NCDOT, the location is …NCDOT_CONNECT_WORKSPACE\Configuration\Organization-

Civil\NCDOT\Image. 
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19. In the raster attachment options set the Level and Class as shown below, then Click 
Attach. 
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20. The raster image is attached. 

 

 

21. Switch back to the Default model and the raster image will be shown there as well.  It 
shows here because of the reference attachments which were preconfigured in the seed 
file, as described in Exercise 1.  
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22. NOTE: Often, the raster image will slow display performance. If the redraw performance 
becomes uncomfortably slow, or if the image is simply too much information, you can 
turn off the display of the image using the Reference Manager and turn off the display 
of the Raster model. 
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Exercise 3: Layout the Public Hearing Map Sheets  

In this section we will create sheet layouts for the public hearing maps. Since the sheets may be 
up to 10ft long (Unless prior coordination with Public Involvement Officer indicates the facility 
and method of display can accommodate additional length), many projects will consist of a 
single sheet. The general workflow for this exercise is: 

• Define the limits of the sheets (Named Boundaries) 
o Maximum plotted length = 10’. 
o Usual plotted width is 36”. 
o The project length and curvature will affect length and sheet count. 

• The named boundaries are then used as clipping limits to create: 
o Drawing models 
o Sheet Models 

• Scale - According to the design manual, “consider using a scale of 1” =100’ for “curb 
type” urban widening projects and a scale of 1” = 200’ for rural new location projects.” 

The process is similar to creating sheets for roadway plans except there are more manual inputs 
to account for the non-standard sheet sizes. 

NOTE: In many portions of this and following exercises, the aerial image has been turned off for 
better clarity. 

Create Sheet Boundaries 

1. To get everyone back on the same page, switch to file …\Roadway\Sheets Exercise 3\HL-
0008F_RDY_PHM.dgn. 

2. We will want to clean up the view a bit by turning off some of the reference 
attachments. Open the reference manager (OpenRoads Modeling > Home > Primary > 
References) 

 



 

Module 14 – Public Hearing Map 

 

 

Page | 29  

 

 

3. In the reference manager, turn off the survey file references. 

 

4. Close the reference manager. 
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5. You can make things on-screen clearer still, by turning off some of the unnecessary 
levels.  For the moment, we really only need to see the roadway alignments and enough 
other information to properly orient ourselves along the project. 

 

6. Next, we will want to rotate our view to be aligned with the roadway alignment. Start 
the Rotate View command from the View 1 window. 

 

7. In the rotate view command, we will change the method to 2 Points using the drop 
down. 
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8. For the first point pick the beginning of the proposed alignment. Exact is not needed; 
close is good enough. We just want our view set so that the alignment is approximately 
horizontal on the screen. 
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9. And for the second point pick the end of the alignment. 

10. This will align the view in a way which is more natural. Save settings. 

 

11. The next step will be creating a named boundary (i.e. layout clipping shapes) that we 
will use for producing the final maps. In previous modules, the named boundaries have 
been based on the proposed roadway alignment. We will follow a similar workflow 
here. 
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12. Start the Named Boundaries command (OpenRoads Modeling > Drawing Production > 
Named Boundaries > Place Named Boundaries). 

 

13. The Place Named Boundary dialog will pop up. There are several options at the top for 
different boundary types. For this exercise, we will be using the “Civil Plan” option. 
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14. From the introduction to this exercise, note that a scale of 1”=100’ is appropriate for an 
this project.  Select Plan 100 Scale for the drawing seed. 

 

15. Selecting the drawing seed automatically sets Detail Scale to 1” = 100’. 

16. Next, provide a name and description for the boundaries being produced. Use generic 
names so that the boundaries can be used for both the Corridor Public Hearing Maps and 
the Design Public Hearing Map. We will use the naming convention “RDY PHM Sheet *” 
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for the boundaries. Therefore, this first boundary name will be “RDY PHM Sheet 1.” Fill in 
the description with the same. 

 

17. The Group is used so that related sheets can be clustered together.  Since we have not 
made any sheets yet, our only choice is to make a new group as shown above. 

18. Ignore the name for the group right now. It will get automatically populated below. If 
we input something now will just get over-written in a moment. 

19. The next inputs (Start Station and Stop Station) will come from the alignment that we 
select. If you look at the bottom left of your screen the prompt will indicate to select the 
path element. The roadway alignment will be our path alignment. 
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20. Select the roadway alignment. 

 

 

21. After selecting the alignment, notice that the name of the group has been set to “L”.  
We could change this now, but we’ll wait a minute since we need to adjust some other 
values as well. 

 

22. After the alignment is selected, we can set the start station. A white guideline will allow 
you to dynamically select the start station. Moving as far left as possible will show that 
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the start station is 10+00.00.  But we usually will want a little extra space (Optional) 
before the first sheet.  So, key in 5+00 in the dialog and lock this value. 

 

23. Left click in the drawing to accept the start station. 

Important: Do not complete the next step until instructed.  We will first review how the 
sheets automatically laid out. But before accepting those sheets, we will change the sheet 
dimensions. 
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24. After we set the start station, we can dynamically select the end station. As you Move to 
the end station and select the end point, notice how multiple boundaries can be 
created.  

The length (2800’) and width (1800’) from the dialog are being used to determine boundary 
limits and shape. 

 

25. Before we accept these boundaries, we will want to adjust some items in the dialog: 

A. Change group name to “RDY PHM Sheets.” 

B. Change the Length to 5900 ft, which is the difference in the station range of the 
centerline plus 500 ft on each end and then rounding up. NOTE: for a longer project 
which requires multiple sheets you would not use 5900ft.  See note at end of this 
exercise for guidance. 

C. Change both the left offset to -1725 ft and right offsets to 1725 ft. This provides a total 
width of 3450 ft (34.5 plotted inches) with 1.5 inch available for margins (0.75” top and 
0.75” bottom). 

D. Set Boundary Chords to zero so that we get a rectangular shaped boundary, rather than 
a curved top and bottom edge. 
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26. With these changes in place in the dialog, move your cursor back into the drawing to see 
a preview of the boundaries you would get with these settings. 

 

27. If the the boundary is slightly offset.  We could change the left and right offset a bit to 
make things more centered. 
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NOTE: Shifting the offset like this does have an unfortunate side effect. When the sheets are 
cut later this offset will be reflected in an offset of the reference files attached to the sheets. 
This is an apparent shortcoming in the software. 

 

28. Make sure the create drawing box is not checked. If it is checked, the drawing and sheet 
models will be created instantly, which we do not want. 

 

29. Left click in the view, making sure cursor is at least to the end of the alignment, which 
will create the boundary. 
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30. After the named boundary is placed, we can adjust it as needed. We can use any of the  

following commands (probably more) to get the boundary just like we want it: 

A. Move 

B. Rotate 

C. Insert Vertex 

D. Delete Vertex. 

Guidance on Sheet Length: As described in the introduction to this exercise, the maximum 
length for a hearing map is 10 plotted ft. This amounts to about 2.27 miles at 100 scale and 
1.136 miles at 50 scale.  If our project were longer than this one, we would simply have more 
boundaries at this point. Adjacent boundaries would have a common match line.  Thus, instead 
of 5900 ft for sheet length as we used above you might use: 

• Very long project sheet length might be 12,000 at 100 scale and 6,000 at 50 scale. 
(approx. 2.27 miles and 1.136 miles) 

• You might run the named boundary command multiple times with a variable sheet 
length each time to (for example) cause match lines to land between intersections. 

• For projects with lots of curvature you might run the named boundary command 
multiple times with a variable sheet length which best fits the curved road onto straight 
sheets. 
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Create Sheets 

31. To get everyone back on the same page, switch to file …\Roadway\Sheets Exercise 3A\HL-
0008F_RDY_PHM.dgn, which will show a completed boundary.  

32. Now that we have created the named boundary(ies), we will use it to create our 
sheet(s). In the Drawing Production ribbon, open the Named Boundaries Manager 
(OpenRoads Modeling > Drawing Production > Named Boundaries). 

 

NOTE: This command is a little odd. What you are clicking here is the little drop down 
arrow. 

33. Expand the plans group to see the group created above. 

 

34. Expand the group to see the named boundary we created above. 
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35. Now, we will want to create plan sheets. Before creating the sheets, click the pencil icon 
(Show Create Drawing Dialog). This will force the create drawing dialog to open while 
we are creating the sheets, allowing us to tweak the inputs. 

 

NOTE: this button is also a little odd because it is an On/Off toggle, not a command button. 
All it does when toggle on is to inform the software that we wish to see a dialog pop-up 
rather than let it automatically create things. 

36. Right Click on the RDY PHM Sheet 1 boundary and choose Create Plan Drawing. 

 

37. The Create Drawing dialog will open. 
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38. In the dialog, most of the settings will already be correct because of the seed file we 
used when creating the named boundary. 

A. Change the name to just “RDY PHM Sheet 1.” 

B. The drawing model annotation scale is 1” = 100’ 

C. Sheet model annotation scale is Full Size 1 = 1. 

D. The check box for Add to Sheet Index should be checked. 

E. Open Model is not checked. 
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39. Click OK to create sheet and drawing models. Almost nothing will visibly occur, except 
you may see the progress bar run green in lower right of screen. 

40. To see the models which were created, open the model manager dialog (OpenRoads 
Modeling > Home > Primary > Models).  

 

41. In the model dialog, scroll until you find the RDY PHM Sheet 1. You will notice there is 
now a RDY PHM Sheet 1 drawing model as indicated by the gray icon and a RDY PHM 
Sheet 1 [Sheet] model as indicated by the different white icon. 

 

42. Open the model named “RDY PHM Sheet 1 [Sheet]” by double clicking on the name. 
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43. You will now see a proposed border that was placed by the Create Drawing command 
when the sheet model was created and a sheet edge. And you will note that the border 
is too small for the sheet. 

 

NOTE: Since every hearing map sheet (even different sheets on the same project) is 
potentially a unique size, our process in these above steps was to get as much from the 
default sheeting setups as possible and then add custom sheet borders as needed. 
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44. Delete all the lines and text of the standard sheet border and title block which were 
created as part of the sheeting process above. Be careful and do not delete the special 
text indicated below and the associated boundaries. 

 

45. The next step will be changing the sheet boundary size. We know the height of the 
sheet is 36”. We will still need to determine the width. To do this, use the measure 
distance command (OpenRoads Modeling > Drawing > Measure > Measure Distance). 
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46. We will use the between points method. We will measure the long edge at the top of 
named boundary in the attached reference file, which is about 4.9 ft (58.8 in). 

 

47. We will round this to 5’ (60”). Then to get the total width, we will need to account for 
the proposed border flaps. There are two flaps at 9” of width which means we need to 
add 18” to our width for a total width of 78”. The final dimensions of our sheet are then 
36”x78”. 

48. Now that we know the necessary sheet space, we are ready to adjust the sheet 
boundary size. Open the model manager (OpenRoads Modeling > Home > Primary > 
Models). 
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49. Once the model manager is open, select the RDY PHM Sheet 1.  Then click “Define Sheet 
Boundary”. 

 

50. The sheet boundary dialog will open. Change size from ANSI D to Custom. 

 

51. The custom sheet size will pop up. Key in our determined size (36” x 78”) and click OK. 
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52. Upon closing the sheet boundary dialog and the Model manager, you will see the sheet 
boundary size has increased, but is still misaligned. 

 

53. Turn your attention back to the Sheet Boundary editing tool and click on Move button. 
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54. The From point is the corner of the sheet boundary. 

 

55. And the To point is the corner of the Named Boundary which is in reference file. 
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56. Then move once more by a value of 9.6” (0.8’) left and 0.5” (0.04167’) down. Accudraw 
is your friend here. 

 

57. Our Sheet border is now aligned with the named boundary. 
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58. Now, we will want to place a Hearing Map sheet border. Open the place cell command 
(OpenRoads Modeling > Drawing > Placement > Cells). 

 

 

59. Once the command is open, we will need to set the correct active cell. Select the ellipses 
next to the active cell text box to open the cell library. 

60. When the cell library dialog opens, toggle on the button to “Display All Cells in MS-
CellList”. 
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61. From the cell list, select the cell named “PHM Sheet Border”. Set it active by double 
clicking with a left click. 

 

62. Make sure scale is set to 1.0 and then place the cell by snap at the bottom left corner of 
the sheet boundary. 

 

63. You will notice that the sheet border is much longer than the sheet boundary. This is 
because the sheet border is set up for the maximum length for public hearing maps 
(10’). 

64. To make the sheet boundary the correct size, we will use the stretch command 
(OpenRoads Modeling > Drawing > Manipulate > Stretch). 
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65. First prompt of the stretch command is placing a fence. The area you want is the center 
of the border. 

 

66. Using midpoint snap, move this fenced area from center of the black hearing map 
border to the midpoint of the named boundary or any other location. 
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67. This will shift the legend and labels to the center. 

 

68. Now we will use the same command to shift the border edge to be even boundary edge. 
Set a fence including the end flap. Using key point snaps, move from the corner of the 
hearing map sheet to the named boundary corner. 

 

69. Now, our sheet border matches the named boundaries extents. 
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70. Now we can edit some of the information found in the border to be project specific. We 
will start with the design data. To edit the cell, select the edit text command 
(OpenRoads Modeling > Drawing Production > Text > Edit Text) 

 

71. Select the data information to edit it. In text editor, double click on the fields to edit 
them. Update the information to the correct functional class, design speed and 
maximum super elevation. 
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72. Continue with the edit text command, to update all the labels in the information block 
shown below.  This information block is at three places (left, right and top).  All three 
need to be edited. 

 

 

Note: To attach the State Seal and Triskelion Logo, go to OpenRoads Modeling > Home > 
AttachTools > Raster Manager > File > Attach > Raster > Select the PNG files > Attach. The cursor 
will change to a plus symbol. Choose the green square from corner to corner to place the image. 

(Not needed for this module, already included with the border) 
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73. If you turned off the aerial image above, you may want to turn it back on now. 

 

74. In the next exercises, this sheet will be further refined by: 

A. Adding various shapes as required by standards 

B. Adding annotations 

C. Adding reference clipping and clip masks 

D. Turning levels back on as needed for the hearing map. 
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Exercise 4: Create Bounding Shapes of Existing Features 

The Public Hearing map needs to emphasize a variety of existing features.  In this section, we 
will create various shapes which bound these areas of interest. The production of these shapes 
will use the survey data and aerial images for limits of the shapes.   After the shapes are 
created, they will show on the hearing map sheets because the referencing has already been 
setup in the seed file we started with. 

In this exercise, we will create shapes using the following methods: 

• Create Shape command – suitable for irregular shapes (IE corners are not necessarily 
90°) bodies of water. 

• Create Orthogonal Shape command – suitable for shapes with 90° corners such as 
buildings. 

• Create Complex Shape – suitable for shapes where survey data was collected but the 
features are individual lines or line strings rather than shapes. This can occur with any 
type of feature including buildings, water bodies, historical boundaries and wetlands. 

• Create Region command – suitable for large irregular areas such as existing right of way 
or existing pavements. 

The following lessons are designed to provide the designer with a set of tools which will serve 
for any project’s hearing map.  Every project is unique and the choice of tools and even the mix 
of suitable tools will vary from project to project. 

The exercises below do not cover creation of shapes for every feature type. The designer will 
use a mix of the tools presented to create the various shapes for any particular project. 

Create Region Command 

In this section we will create the shapes for an existing Building and small lakes.   

We’ll use the Create Region command, which has the advantage of allowing a flood fill 
workflow.  Of course, we’ll need to draw some scratch lines to close any openings at the ends 
to allow flood fill to work. 

1. …/Roadway/Sheets Exercise 4/HL-0008F_RDY_PHM.dgn 
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2. Turn survey and historic property boundary reference files back on.  

NOTE: It is easier to turn these references back on in the default model so they will be visible in 
the Exist Boundary Line model when we go there. 

3. Open the model manager (OpenRoads Modeling > Home > Primary > Models) and 
double click to open model “RDY PHM Exist Boundary Line”, then fit view. 
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4. Pan and zoom to near where there is a Historic Property. 

 

NOTE: You may find it useful to rotate the view like the above image. Using the corners of 
the named boundary to define the rotation is a good idea. 

5.  For this shape, we are only concerned about the E_RDY_Historic_Property_Boundary. 
We want to turn off all levels except the E_RDY_Historic_Property_Boundary. Start the 
Level Display command. 

6. Collapse the reference file hierarchy as indicated below. 
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7. Right click in the level list and then click on All Off. 
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8. Then expand the attachments list, scroll down to the HPB Boundary file and make sure 
only level named E_RDY_Historic_Property_Boundary is on. 

 

9. Set the active symbology by choosing the element template E_PHM_Exist Boundary Line 
(OpenRoads Modeling > Home > Attributes > Element Template) 

  

NOTE: Setting the element template, sets the correct level, color, and transparency. 
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10. Toggle on the element template association (Toggle button at arrow above).  

NOTE: By having the Element Template Association toggle turned on, the elements which get 
drawn are tagged with the name of the element templates. Thus, if the template ever changes 
in the future, the drawn elements will update automatically. 

11. Start the Create Region command (OpenRoads Modeling > Drawing > Groups > Create 
Region). 

 

12. Confirm the fill options in the dialog as shown below. 
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13. Move the cursor inside the shape. 

 

14. Click inside the Historical Property shape. 

15. The finished Historical Property Boundary is now created. 
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Create Shape Command 

1. We will use the same workflow as above to create a shape for existing water features. 

2. Open the model manager (OpenRoads Modeling > Home > Primary > Models) and 
double click to open model “RDY PHM Exist Water Shape”. 
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3. Pan to near the locations below. 

 

4. Set the element template to “E_PHM_Water” 

 

5. Start the Place Shape command (OpenRoads Modeling > Drawing > Placement > Place 
Shape). 

 

6. Set the fill options in the dialog as shown. 
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7. Draw a shape similar as shown below to create the small pond. 
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8. The water shape is now be created. 

 

9. Continue create the next water shapes by using Create Region command (OpenRoads 
Modeling > Drawing > Groups > Create Region).  

 

Note: Create Region command applies to closed areas therefore we need to close the next 
3 shapes by using Place Line command. 
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10. Close the shapes, use Scratch_Level_1.  

11. Start the Create Region command (OpenRoads Modeling > Drawing > Groups > Create 
Region).  



 

Module 14 – Public Hearing Map 

 

 

Page | 72  

 

 

12. Click inside to create the shape. 

13. Turn off the FS reference file and check the shapes. 

 

 

 

 

  

Create Ortho Shape 

In this section, we will create some building shapes using the Create Ortho Shape command. 
The Create Ortho Shape command is similar to the create shape used above, except every 
corner will be 90°. This command might be useful for buildings which are outside the limits of 
the survey, thus not important to the surveyor or designer, but still important for the hearing 
map. Buildings within the survey limits will have been surveyed already and thus shapes for 
these buildings will exist already in the survey file. 

1. Continue in the same file. 
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2. Open the model manager (OpenRoads Modeling>Home>Primary>Models) and double 
click to open model “RDY PHM Exist Building Shapes”. 

 

3. If the aerial image is not visible, the model which is referenced and contains the image 
may be turned off.  A check of the Reference manager will not help because we are 
using live nesting, thus the only attachment we see is the default model. 

 

4. We could switch back to the Default model to turn on the attachment, but we can also 
use level display (OpenRoads Modeling > Home > Primary > Level Display). 

5. Level Display can be handy here because it easily shows all the nested attachments, and 
we can right click on the raster model to turn it on. 



 

Module 14 – Public Hearing Map 

 

 

Page | 74  

 

 

 

 

6. Set the element template to “E_PHM_Building.” (Make sure to have the element 
template association toggled on.) 

 

NOTE: Use Create Region method described above (Page 65) to create most building 

shapes except two buildings, mentioned below.  
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7. Pan and zoom to the area indicated below.  (sometimes you see some houses were not 
surveyed because they are outside the scope of the project but may be important to 
emphasize for the hearing). Zoom in to the end of the project on the left side.  

 

8. Start the Place Orthogonal Shape command (OpenRoads Modeling > Drawing > 
Placement > Place Orthogonal Shape). 

 

 

9. Set the fill options in dialog as shown below. 
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10. Works by tracing the edges of the roof. After the first two points are set, the remaining 
lines will be drawn orthogonally. 

 

11. The shape will close when you complete the circuit back to the starting point. 
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12. The existing building is created. 
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Create Complex Shape 

This section, we will explain create some building shapes using the Create Complex Shape 
command. This is most commonly done for buildings in which the survey data was collected as 
lines which are not closed. 

1. Continue in the same file. 

2. Continue in the model named “RDY PHM Exist Building Shapes”. 

3. Pan and zoom to the area shown below. 

 

 

4. You may turn off the raster image if you wish. 

5. In this area is a building which is not already closed shape. For whatever reason, this can 
happen.  We’ll use the Create Complex Shape command to close it up. 

6. Set the active element template to “E_PHM_Building.” (Make sure to have the element 
template association toggled on.) 

 

7. Start the Place Shape command (OpenRoads Modeling > Drawing > Groups > Create 
Complex Shape). 
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8. For this exercise, we will use the automatic method. Also, confirm fill type and fill color 
are correct as shown below. 

 

9. Pick one of the line strings. 
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10. Then left click again, anywhere on the screen. 

11. The entire shape will be closed as the command finds lines which connect. 

12. Left click once more to accept and create the shape. 
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Create Region for right of way shape. 

In this section we will create the shapes for existing right of way and easements.  We’ll use the 
Create Region command again. 

1. Continue in the same file. 

2. Open the “RDY PHM Exist Right of Way Shape” model by double click in the Model 
Manager. 

 

 

3. For this shape, we are only concerned about the existing right of way lines and Exist 
Roads EOP. We want to turn off all levels except the existing right of way lines and Exist 



 

Module 14 – Public Hearing Map 

 

 

Page | 82  

 

 

Roads EOP. This is complicated a bit because we are using nested attachments in this 
file. Start the Level Display command. 

 

4. Collapse the reference file hierarchy as indicated above. 
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5. Right click in the level list and then click on All Off. 

 

6. Turn on Scratch _Level_0 (We will use it as a guide to define the limits and shape 
closure). 
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7. Then expand the attachments list, scroll down to the FS file and make sure only levels 
named Exist Right of Way Line and Exist Roads EOP are on. 
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8. Set the Element Template to …\Roadway\Linear\Miscellaneous\CCE_Target_1. These 
CCE items are multi-use for a variety of scratch or construction purposes. 

 

 

9. Theoretically, all property parcels and right of way are closed shapes. After all, the right 
of way is simply a parcel which is owned by the State. However, since we never survey 
the full extents of the right of way (which extends almost infinitely) there will be open 
ends as shown below. These openings need to be closed if we wish to use flood fill to 
make a shape. 
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10. Use the Place SmartLine command (OpenRoads Modeling > Drawing > Placement > 
Place SmartLine) to draw a line across the open ends.  You could draw 7 little lines, or 
one big line string as shown below. Make sure Join Elements is off. 

 

Note: Use the monuments (scratch _Level_0) in this model as guides to locate the starting 
and ending construction points for the main and minor roads. Once the shapes are created, 
deactivate the level and save the settings. 

11. Set the element template to “E_PHM_ROW.” 
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12. To create the shape, we will use the Create Region command. Select the Create region 
command (OpenRoads Modeling > Drawing > Groups > Create Region). 

 

13. We will use the flood method. Make sure the settings are correct. We will use a 
maximum gap of 1 for now. 

 

14. Make sure that “Associative Region Boundary is turned on. This associates our new 
shape with the detected boundaries, so that we can easily edit the shape later. 
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15. Left Click inside the boundaries of the right of way and edge of pavement areas. 

 

16. The shapes are created. 

 

NOTE:  If the proper shapes are not detected then either your scratch lines are incorrect, 
leaving a gap, or there are gaps in the right of way lines, which should not be. 

17. Often, upon review by the NCDOT, they will ask that the limits of this existing right of 
way shape be reduced or expanded.  In fact, as created above, our shape is almost 
certainly too large.  However, since we used an Associative Boundary, we can easily edit 
the shape extents. 

18. Pan and zoom to the area pointed at below, where we have much more right of way 
shape than the limits of construction. 
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19. We can change the right of way shape because it is an Associative Shape, by changing 
the boundary elements.  Select the scratch line we used to close the ends of the right of 
way. 

20. Then move the vertices closer to the end of the project (50’). 

Note: Turn on Scratch_Level 3 to find the limits. 
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21. The shape for the existing right of way is thus reduced to match the changed boundary. 

 

22. To create the existing easement shapes would be similar to above: 

23. Continue in the same model. 
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24. For this shape, we are only concerned about the existing right of way easement lines. 
We want to turn off all levels except the existing right of way easement line and exist 
property line. Start the Level Display command. 

 

 

25. Collapse the reference file hierarchy as indicated above. 
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26. Right click in the level list and then click on All Off. 
27. Then expand the attachments list, scroll down to the FS file and make sure only levels 

named Exist Right of Way Easement Line and Exist Property Line are on. 

 

28. Set the element template to “E_PHM_Utility Easement.” 

 
29. To create the shape, we will use the Create Region command. Select the Create region 

command (OpenRoads Modeling > Drawing > Groups > Create Region). 
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30. We will use the flood method. Make sure the settings are correct.  

31. Left Click within the limits of the existing right of way easement line. 
32. The shapes are created. 
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Creating Existing Roadway Shapes 

1.  To get everyone back on the same page, open file …/Roadway/Sheets Exercise 4A/HL-
0008F_RDY_PHM.dgn 

2. Change to model “RDY PHM Exist Roadway Shape” 

3. Using Level Display, turn off all levels except for the “Exist Roads EOP”  

 

4. We could do either of the following commands for this shape: 

A. Create Complex Shape.  

• Set the Element Template to E_PHM_Roadway. 
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• The tool we will use the create complex shape command. Select the Create 
complex shape command. (OpenRoads Modeling > Drawing > Groups > Create 
Complex Shape) 

 

 

• Set the parameters in the dialog as follows: 
Method: Automatic – There are hundreds of line segments.  Larger 
projects may have thousands.  Even if the slope stake lines are complex 
elements, the way this command works is one segment at a time, so 
Manual method is a non-starter. 
 Maximum Gap: 100 ft.  This will allow the command to jump across the 
gaps when detecting the next segment.  This value will vary from project 
to project and may require some trial and error. If you measure across 
the largest gap (for example from left side of ROW to right side) will 
provide a guide to set this value. 
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• Select the first line segment.  Theoretically, you can start anywhere, but we will 
start at upper right. 
 

 

• Then you will left click, repeatedly, as the connecting segments are found. What 
is happening is that at every click, it is detecting two possible paths. One path 
continues down the line, but another path is a segment on the other side of the 
road.  With some tweaking of the Max Gap setting, you might be able to limit the 
number of required clicks. 
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• The tool should first try to connect to the next adjacent line segment so that 
basically, you will be click, click, clicking a few dozen times until the shape is 
closed. 

 

 

B. Create Region with flood fill – will probably be a better choice here, although we still will 
need to do some work to control the flood effect. 
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• Set the active element template to \Roadway\Linear\Miscellaneous\CCE_Target_1, 
so we can draw some scratch lines. 

 

• Then draw smart lines similar to below. There are several gaps in the surveyed edges 
of pavement which will have to be closed. 

       Note: A line has been positioned at the beginning of the project to indicate the starting  
and ending points for drawing the line. 

TIP: It may be easier to temporarily cut off patterning of line styles in the view attributes 
because the dashed pattern of the EOP makes the gaps harder to locate. 

 

5. Then you will want to set to navigate the element template to set the 
“E_PHM_Roadway.” 
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6. Start the Create Region command. 

 

7. Click the mouse cursor inside of the EOP lines. The shape will be highlighted. 
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8. Left click once more to accept creation of the shape. 

 

 

 

9. Turn on the Proposed edge of pavement level in the level display. So we can designate 
the existing pavement that is to be removed, which we don’t have in this project. 
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Exercise 5: Create Bounding Shapes of Proposed Features 

The shapes for the proposed features are created using the same tools as used for the existing 
features in previous exercise.  Thus, most of the exercises to follow will be somewhat repetitive 
of what we learned above.  However, several of the proposed feature types have unique 
challenges, such as required hatching or shapes whose boundary is a different color than the 
fill. 

Although each of the following exercises utilizes a specific tool, any individual project may be 
found to work better by using one of the other tools covered in Exercise 4. 

In the following some items are shown the Design Public Hearing Map. The Designer is directed 
to “Public Involvement Map Information Guide 8-03-2020” to determine which information is 
shown on which map. 

Creating Proposed Roadway Shape 

1. To get everyone back on the same page, open file …/Roadway/Sheets Exercise 5/HL-
0008F_RDY_PHM.dgn 

2. Change model to “RDY PHM Prop Roadway Shape”. 
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3. Turn off all levels except for the  

A. “P_RDY_Edge_of_Travel” level in the DSN file. 

B. “Exist Road EOP other” and “Exis Roads EOT” levels in the fs file. 

 

4. Set the active element template to “P_PHM_Roadway.” 
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5. Start the Create Region command.  

 

6. Click somewhere inside the paved area. 

 

7. Similar workflow as above can be used for temporary or detour roadway shapes and 
future roadway shapes. 
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Creating Proposed Future Roadway Shape 

1. Continue in the same file …/Roadway/Sheets Exercise 5/HL-0008F_RDY_PHM.dgn and 
same model “RDY PHM Prop Roadway Shape”. 

2. Attach …\Roadway\Design\R2828_rdy_dsn_A.dgn 

 

3. Turn off all levels except for the P_RDY_Edge_of_Travel in DSN file, Prop EOT in R2828 
dsn file and P_PHM_Roadway Shape. 

 

4. Set the active element template to “P_PHM_Future Roadway.” 
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5. Zoom in to the beginning of the alignment. 

 

6. Start the Create Region command and click somewhere inside the paved areas.  
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7. Use union method from create region command to make one shape, uncheck keep 
original option then select both shapes. Union areas will make it easier to select one 
shape instead of multiple shapes. 

 

 

8. The shapes require a hatch. We could use the hatch command, or we can add a hatch in 
the element properties. 

 
9. Select the shape we just created.   
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10. In the Properties panel change Pattern Definitions from None to User Defined. 
11. Then set the hatch parameters as shown below. 

 
12. We want the proposed roadway shape to have a boundary, which we can do in the 

properties. Select the shape and open Properties. (OpenRoads Modeling > Home > 
Primary > Properties). 
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13. First change the color to zero (black). This will also change the fill color to zero. 

 
14. Then change the fill color back 4(yellow) 

15. Detach R2828_rdy_dsn_A.dgn. 
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Creating Existing Roadway to be Resurfaced Shape 

1. Continue in same file. 

2. Switch to model “RDY PHM Exist Roadway Shape to be Resurfaced”. 

3. Using the Level display and the All Except Element command, turn off all levels except 
for: 

A. “E_PHM Roadway Shape” in model RDY_PHM_Exist Roadway Shape 

B. “P_PHM Roadway Shape” in model RDY_PHM_Prop Roadway Shape 

C. “Exist_Roads EOT” in fs file 

D. “P_RDY_Edge_of_Travel” in DSN file 
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4. Set the element template to “E_PHM_Roadway to be Resurfaced.” 

 

 

5. Place a small line to close the shape at the end of the project. 
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6. Start the Create Region command and create multiple shapes using the flood method. 

 

NOTE: This project will require multiple shapes to cover the portions where the proposed 
roadway overlaps the existing pavement. Left click to inside the areas below to create a region. 
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Creating Proposed Right of Way Shape 

1. To get everyone back on the same page, open file …/Roadway/Sheets Exercise 5A/HL-
0008F_RDY_PHM.dgn 

2. This information will be stored in a separate model under “RDY PHM Prop Right of Way 
Shape” model using the Model Manager. 

 

3. Set the element template to set the “P_PHM_ROW.” 
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4. Using the Level display, turn off all levels except for: 

A. “P_RDY_ROW_RW_Lines” in attachment HL-0008F_RDY_Alt2A_ROW.dgn 

B. “Exist Right of Way Line” in attachment hl0008f_ncdot_fs.dgn  
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5. Open the create region command and use the flood method. 

 

6. Create a shape for each area of proposed right of way acquisition.  There are 4 shapes in 
this project. 

 

Creating Proposed Easements Shape 

1. Continue in file …/Roadway/Sheets Exercise 5A/HL-0008F_RDY_PHM.dgn 

2. Change to “RDY PHM Prop Easements Shape” model. 
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3. Using the Level display, turn off all levels except for: 

A. “P_RDY_ROW_RW_Lines” in attachment HL-0008F_RDY-Alt2A_ROW.dgn 

B. “P_RDY_Easement_Construction” in attachment HL-0008F_RDY-Alt2A_ROW.dgn 

C. “Exist Right of Way Line” in attachment hl-0008f_ncdot_fs.dgn  

 

 

4. Set the element template to set the “P_PHM_Easements” 
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5. Open the create region command and use the flood method. 

 

6. Create a shape for each area of proposed easements.  There are 11 shapes in this 
project. 

 

7. The easement shapes require a hatch.  We could use the hatch command, but we will 
explore an alternative method. We can add a hatch in the element properties. 
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8. Select all the 11 shapes we just created.  This can be done easiest by turning off the 
other levels. 

 

9. In the Properties panel change Pattern Definitions from None to User Defined. 
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10. Then set the hatch parameters as shown below. 

 

11. The result is a hatch pattern which is part of the element. 

 

12. We want the easement shape to have a boundary, which we can do in the properties. 
Select the shape and open Properties. (OpenRoads Modeling > Home > Primary > 
Properties). 
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13. First change the color to zero (black). This will also change the fill color to zero. 

14. Then change the fill color back 152 (green) 
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Creating Proposed Structures/Existing Structures to be Removed Shapes 

1. To get everyone back on the same page, open file …/Roadway/Sheets Exercise 5B/HL-
0008F_RDY_PHM.dgn 

2. Switch model to “RDY PHM Prop Structure Shape”. 

3. Pan and zoom to the area indicated below where there is a concrete island and curb 
and gutter. 

 

4. Using the level display isolate the level “P_RDY_Concrete_Curb_and_Gutter”, 
“P_RDY_Concrete_Monolithic_Island” and “P_RDY_Edge_of_Travel” in attachment HL-
0008F-RDY-ALT2A-DSN.dgn. 
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5. Set the active element template to set the “P_PHM_Structures.” 

 

6. Use the Create Region command, click inside the concrete islands and curb and Gutter 
limits to create the shape. 
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7. The shapes for existing structures to be removed will need to be done next. Switch to 
the “RDY PHM Exist Structure Shape” model. 

 

8. Turn off all levels except, “Exist Roads EOP Other and Exist Roads Curbs” in the FS file 
and “Scratch_Level_3” in the active model (placed earlier to close the shapes). 

9. Set the active element template to “P_PHM_Structures to be Removed.” 
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10. Start the Create Region command and use flood fill method. 

 

11. Select the shape and change the Pattern parameters to User Defined. 
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Note: Follow the above instructions for Exist Structures, Island, Sidewalk, Curb and 
Gutter to be retained except changing the pattern parameters hatch color to as below,  

 

12. In the previous chapters, we have covered tools which allow creation of the shapes 
used in a public hearing map.  The focus has been on tools, which you will need to 
apply properly to various projects to develop a hearing map.  We used many types of 
shapes as examples in the previous exercises but did not cover every type.  Types of 
shapes which you may encounter but not discussed above can be made using the same 
workflows as outlined above which follow this pattern: 

A. Switch to the appropriate model in the hearing map dgn file. 

B. Using level display, turn off all levels except the ones needed to define the shape at 
hand. 

C. Set the appropriate active element template which will define symbology. 

D. Use one of the above commands to create the shape. 

E. For some shape types add hatching. 

13. The other shape types which were not explicitly covered above include sidewalks, 
culverts and existing structures. 
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Exercise 6: Annotation – Text and Cells 

Portions of the public hearing maps require adding labels to identify common features such as 
streets or areas of interest such as historic boundaries. To place these labels, either the place 
text command with certain text styles or place label command with designated text favorites 
will be used. 

Add North Arrows 

The next steps will add north arrow to the sheets. 

1. To get everyone back on the same page, open file …/Roadway/Sheets Exercise 6/HL-
0008F_RDY_PHM.dgn 

2. Make sure that you are in model “RDY PHM Sheet 1”. 
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3. Rotate the view to unrotated. 

 

4. Start the place cell command OpenRoads Modeling > Drawing > Placement > Place 
Active Cell. 
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5. Select the ellipsis next to active cell to open the cell library. 

 

6. To view all cells at the cell library location path, select the “Display All Cells” icon. 

 

7. Scroll to find the “TSH_NA 83 2001” and double click on the cell name to make it active. 

 

8. Close the cell library. 
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9. With the scale set to 100, place the north arrow at an appropriate location, inside the 
named boundary created earlier. 

 

10. Select the north arrow and drop status OpenRoads Modeling > Drawing > Groups> 
Drop Element. 

 

11. Double click on the text and change the year to 2011. 



 

Module 14 – Public Hearing Map 

 

 

Page | 129  

 

 

 

 

Use Display Rules to Define Fill for Shapes 

Before we continue with labeling, it will be helpful to set the final display of the various shapes 
so that the drawing models look like the final sheet will look.  We’ll do this by use of a special 
display style configured in the seed. 

1. Continue in same file …/Roadway/Sheets Exercise 6/HL-0008F_RDY_PHM.dgn 

2. Switch to model “RDY PHM Sheet 1”. 

NOTE: This is the drawing model which was created as part of the sheet development process 
in Exercise 3.  Drawing models are expressly designed to provide a place for annotations. 
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3. Using Level Display: 

a. Turn on the attached models whose display has been turned off in above 
exercises. 

b. Turn on all levels that are necessary for the final sheet. 
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4. In the top of the view window, open the View Attributes dialog and select Public 
Hearing Map from Display style. Click the ellipsis to the right of the Display Style. 

5.  Then Click the ellipsis to the right of the Display Style. 
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6. Then choose Public Hearing Map as the display rule. 

 

7. This change will alter the display in a number of ways, including showing the buildings as 
filled shapes and adjusting the colors of various features. 
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8. To show these changes in the sheet model  

A. Switch to the sheet model. 
B. Open Attach Tools>References>Select HL-0008F_RDY_PHM.dgn reference. 

 
C. Select Presentation from Properties. 

 

 
 

D. Then select Public Hearing Map for Display Style then Ok. 
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Label Streets 

The street and road names are added using a specialized text style which has been developed 
to display well on aerial photos and in a public hearing context. 

1. Continue in same file …/Roadway/Sheets Exercise 6/HL-0008f_RDY_PHM.dgn. 

2. Set the active element template to “P_PHM_Text Street” 

 

3. Open the Place Text Along Command (OpenRoads Modeling > Drawing Production > 
Text > Place Text Along). 
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4. Zoom and pan to Old Stage RD on the project. 

 

5. Set the method for placement to Above Element (Below Element will sometimes be a 
better choice). 
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6. Type in the road name as shown above. 

 

7. Place the Text by picking one of the road edges. 
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8. Repeat the above to add labels for every street on the project. 
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Label Landmarks 

Notable landmarks in the project area will be labeled both so that hearing attendees can orient 
themselves to what is being displayed on the maps and also to point out areas of special 
concern in the design. 

For this exercise, the Vance Elementary School is located as shown below: 

 

1. Continue in same file …/Roadway/Sheets Exercise 6/HL-0008F_RDY_PHM.dgn. 

2. Landmarks within the project area are to be labeled as well. Set the element template to 
“P_PHM_Text Landmark” 
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3. Start the Place Text Command (OpenRoads Modeling > Drawing Production > Text > 
Place Text). 

 

4. Key in the landmark name and place at the desired location and rotation. 
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Label Beginning and ending TIP project stations 

For the design public hearing map, the L alignment needs to be labeled with beginning and 
ending TIP project stations  

Continue in the same file …/Roadway/Sheets Exercise 6/HL-0008F_RDY_PHM.dgn. 

1. Stay in the “RDY PHM Sheet 1” model. 

2. Set the element template to “P_PHM_Text White” 

 

3. Open the Place Text Along Command (OpenRoads Modeler > Drawing Production > 
Notes > Place Label). 
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4. Set the Label Type to Cell 

5. For Cell Name, you will use two different ones depending on whether the label is at the 
beginning or the end of the alignment. 

A. _Lbl-RDY-Pln_Beg Const-Y-Line 

B. _Lbl-RDY-Pln_End Const-Y-Line 

 

NOTE: Don’t let the “Y” in the cell name bother you. These labels will also work for L. 
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6. Pan and zoom to the area shown below (Beginning of the project west end of L line). 

 

8. Pick the alignment.  Pick the point at which station should be computed. (Intersection 
snap will help). 

 

9. While dragging the label, a bogus station and alignment name will be shown. 
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10. When you drop the label, the proper stations are computed. 

11.  Double-click on the text and edit it to read: 'Begin TIP Project HL-0008F/-L- POT STA 
14+50.00. Repeat this for the end of the aalignment. 

 

NOTE: Add the Begin/End construction labels if the construction extends beyond the TIP project 
limits. 
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Placing Cells Indicating Traffic Signals 

In this exercise, we will be placing symbols at signalized intersections. On our project, there is 
one existing signal at the intersection of the Charles Street and Franklin Street. On other 
projects, there could be a combination of existing and proposed signals. 

1. Continue in same file …/Roadway/Sheets Exercise 6/HL-0008F_RDY_PHM.dgn. 

2. Continue in the same model “RDY PHM Sheet 1” 
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3. Pan and zoom to the intersection of Old Stage RD and Ten Ten RD. 

 

4. Set the element template to “E_PHM_Traffic Signal.” 

 

5. Use Place Cell command as in previous exercise and place cell named “PHM Exist Traffic 
Signal”. 

  

6. Place the cell at the desired location and rotate to the desired angle. 
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7. The proposed and existing cells are described in the table below. 

 
PHM Exist Traffic Signal 

Used to label any existing signalized intersection. Use the 
“E_PHM_Traffic Signal” element template when placing.  

 
PHM Prop Traffic Signal 

Used to label any proposed signalized intersection. Use the 
“P_PHM_Traffic Signal” element template when placing. 
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Property Owner Name Labels 

In this exercise, we’ll add labels for names of property owners.  While we never like to duplicate 
data between files, we will do so in this case because: 

• There can be a lot of property owners and thus a lot of labels to place. 

• We do not yet have automated ways of detecting owner names and making into a label. 

• Especially for older surveys, the text labels in the PRL or fs file may not be set up to 
adjust to a different plotted scale needed on the hearing map. 

• Even if the survey labels could adjust to scale, a great many of them will certainly be in 
the wrong place. 

As a result, this particular exercise is rather inefficient. It is desired that a better workflow can 
be defined in the future. 

1. Continue in same file …/Roadway/Sheets Exercise 6/HL-0008F_RDY_PHM.dgn. 

2. Continue working in the drawing model. 

NOTE: We will be copying the Owner Names from the fs file into the Hearing Map file.  It will be 
easier to select the owner names to be copied if we turn all the attached levels off.  But then, 
we will need an efficient method of turning on the levels needed for the hearing map.  This will 
give us a chance to explore the PHM level filter. 
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3. Open Level Display, collapse the list of attached reference files and turn all the levels 
off. 
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4. Then turn on level Exist Property Owner Text in the referenced fs file. 

 

5. Now, select all the owner names with the Select tool. Don’t worry if there are a few 
extra bits selected from the PHM file. 
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6. After you select the owner names, you will have 55 items selected.  Note in the selector 
that there may be some extra levels selected besides the owner names level. 

 

7. Just click on these extra level names to remove them from the selection set. 

8. With these selected, use the copy command (OpenRoads Modeling > Drawing > 
Manipulate > Copy) to copy these owner names into the PHM file. 

 

9. This will make a copy (from the survey file) of every owner name into the PHM file. 

NOTE: While copying, it is not particularly important to make the copy land right on top of the 
original labels.  One of the major reasons that we are making a copy in the first place is that, 
because of differences in scale we must move, and rotate each label to match the PHM sheet. 

10. We now need to change the style of the copied text to match PHM levels, fonts, text 
styles and etc.  Turn off the Owner level in the fs file and make sure it is ON in the PHM 
file. In other words you only want to be seeing the copies not the survey labels. 
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11. Select all the text elements we copied. 

Hint:  If you think ahead, you can just never deselect the copies after the copy operation 
finishes. 

12. Then, we can use a little trick from the way-back machine. With the text elements 
selected, drop down the active element template picker and choose 
P_PHM_Text_Black as the active element template. 

 

13. Whenever we change active symbology while an element is selected, that element is 
assigned to whatever we change the active symbology. 
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14.  You can prove this by selecting one of the owner names and review the properties. 

 

15. Now, select all the owner names again. 

 

16. Then start the Change Text Attributes command. (OpenRoads Modeling > Drawing 

Production > Text > Change Text Attributes). 
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17. Set the desired text style to P_PHM_General Text and set the Annotation scale lock to 
ON. 

 

18. Left-click to change the style on all the text. 

 



 

Module 14 – Public Hearing Map 

 

 

Page | 155  

 

 

19. Now, we need to turn on all the required PHM levels so we can move/rotate (as 
needed) all these labels.  

20. Then, the labels need to be rotated and moved to properly fit the drawing and look 
good. 

21. Switch to sheet model. 
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Note: Sometimes some levels like E_RDY_Historic_Property_Boundary or any level in fs file 
aren’t showing in the correct scale in the sheet model 

to fix that: (OpenRoads Modeling > Primary >References). 

Select the file and turn off the Scale Line Styles By Reference Scale 
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Exercise 7: Finalize Sheet 

Once all of the shapes are created and all of the special features are created, the final 
production of the maps can be done. 

1. To get everyone back on the same page, open file …/Roadway/Sheets Exercise 7/HL-
0008F_RDY_PHM.dgn 

2. Open the Sheet Model.  

 

3. Before proceeding, use Level Display tool to turn off any stray levels which do not 
belong on the PHM sheet, which may have been overlooked earlier. 

4. In the above exercises, we created various shapes to accommodate Design Hearing 
map type. The Design Hearing is the more complicated than the Corridor Hearing Map 
because it creates many more shape types. In the remainder of this exercise, we will 
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focus on the Design Hearing Map so we can turn off the display of any referenced 
models. 

 

5. Then there a lot of levels which are currently turned on that are not needed for the 
PHM map, turn them off. 

6. We will need to add a clip mask so the title block and legend are more legible. 

7. First create a fence at the top which bounds the title information. (OpenRoads 
Modeling > Drawing > Selection > Place Fence) 

 

8. Place a fence as shown above. 
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9. Open Reference Manager and Select the Sheet Model attachment. Right click on this 
attachment and then click Mask Reference. 

 

10. Repeat the same process to clip design data box and the legend. Left click in the view 
to accept the fence and create the clip. 

 

11. Move the legend and the scale to the right bottom side of the sheet to avoid conflicts. 
Use stretch command. 
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Note: Follow Public Involvement Map Information Guide and Review Checklist for Design 
public meeting/Hearing Maps to include all the necessary notes, 3-D typical sections, aerial 
source and date and the traffic diagram. 



 

Module 14 – Public Hearing Map 

 

 

Page | 162  

 

 

Note: You should always review for improper sequencing (check several overlapping 
references) whenever making a hearing map. At time of the writing of this manual, couple 
things are still in flux which may lead to such errors.  Over time, as the public hearing seed file is 
continually enhanced and polished, such errors should become rare. 

A. We can correct this improper reference file load sequence but need to switch to the 
default model to do so. 

B. Switch to view 1 (where the default model is displayed) and open the Reference 
Manager. 

C. We will look to the slots numbers and move up or down in sequence. Incase this seems 
OK, so we will look further. 

 

D. In the Reference Manager menu go to Properties > Update Sequence 
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E. If this also looks OK. Yet, we still have a problem. 

 

F. So, the last thing we will check is the elements themselves, by way of the element 
templates used to create them. 

G. Open the element templates manager by drop down the list and click Manage. 
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H. Check the settings, and change the priority as required. 

 

 

I. Do you remember way back when we first started making shapes (an ever since), we 
made of point of making sure that the Enable Element Template Association was 
toggled on. This exercise is a good example of the importance of that toggle.  Since we 
always had this toggled on, the various shapes are associated to the element template, 
thus when we change the priority here, the change is immediately reflected in the map. 

 

Side Bar: Translucency Issues 

In the “Public Involvement Map Information Guide 8-03-2020”, new requirements were added 
to make some of the information on the hearing maps translucent.  The requirements are: 

• The Corridor Hearing Map the following are translucent: 
o Corridor Alternatives shapes   
o Shapes in models “RDY CPHM Corridor Shape Alternate x” 
o Existing Utility Easements 
o Historic Property 
o Parks 
o Cemeteries 
o Railroad Right of way. 
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• For the Design Hearing maps, the following are translucent: 
o Proposed right of way. 
o Proposed Easements. 
o Existing Utility Easements 
o Historic Property 
o Parks 
o Cemeteries 
o Railroad Right of way 
o Proposed express Lane 

A minor issue can occur when two or more translucent shapes overlap.  The overlapping 
translucent colors will result in a perceived color change in the overlapping area. This will most 
often affect areas where: 

• Corridor alternatives overlap. 

• Proposed right of way or easements overlap existing easements. 

One of the reasons we constructed some shapes in multiple pieces is to help avoid such 
overlaps.  However, you will occasionally run into such problems, especially in these last 
bulleted situations. In such cases you will often have no choice except to live with the color 
shift. 
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Exercise 8: Printing 

Ultimately, the hearing map must be plotted for display at the hearing location.  In this exercise, 
we will print the map to a PDF file. 

Printing of raster images can be slow at times. On the author’s computer, this sheet printed in 
about 5 minutes.  So, be sure to plan for several minutes downtime before starting creation of 
these PDF files.  It is not outside the realm of possibility that very long maps with very high 
resolution aerial imagery could take 30+ minutes to print. 

Using Print Commands 

1. To get everyone back on the same page, open file …/Roadway/Sheets Exercise 8/HL-
0008F_RDY_PHM.dgn 

2. Open the sheet model, “RDY PHM Sheet 1 [Sheet]. 
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3. Before we start printing, it will be valuable to remind ourselves of the sheet size.  Open 
the Model Manager and select the sheet model. 

4. Click the button for define sheet boundary so we can review the size we set on page 
49. 

    US Survey Feet                                                                           US Survey Inches 

(Check page 176, how to change the Master Unit) 

 

5. Make note of the 36” x 78” (3’x6.5’) size 

6. Open the Print command (File > Print > Print) 
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7. The plot configuration named RD_pdf should load automatically since it is the default 
configuration as defined in the workspace. However there are some significant 
differences in the printing needs of a hearing map, so we will load a different 
configuration. 

 

8. Click on the ellipsis marked above and then choose RD_Hearing Map.pltcfg. 
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9. Notice that the preview changes to full color.  There are other changes as well. 

We need to enter our paper size to match our custom sheet as shown below.  

 

Please note that a scale factor of 0.08333317 will be displayed when the design file's working 
unit is set to US Survey Feet.  

Setting the Master unit to US Survey Inches will result in a scale of 1.0. 
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Note: For some users the Paper Size Editing tab is off by default in the print window to bring it  

(From Print window > Settings > Preferences > Allow paper size editing) 

Another way to add a custom paper size: (From Print window > File> Edit Printer Driver 

Configuration> Add) Then save changing 
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Note: In ProjectWise, workspace files like the printer driver configuration (.pltcfg) that allow 
users to add a custom paper size are read-only. As a solution, copy the .pltcfg file from your C 
drive to your project folder in ProjectWise to add the custom size. 

10. In the print dialog, go to Settings > Raster Options to change the brightness (User 
preference).  
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11. The preview will be updated. Then click “Print to File”. 

12. You will be prompted for a filename.  Choose the …/Roadway/PDF folder and enter an 
appropriate filename. 

 

13. Click Save.  Printing of raster images can be slow at times. On the author’s computer, 
this sheet printed in less than 10 minutes. 


